Bonus Codes

- Unlock all the championships in the game
- Unlock extra, bonus championships
- Leave the opposition standing with the speed boost
- Unlock and race high speed toy cars
- Get into the groove and race in the slot racing championship
- Make your car impervious to damage and deal out some punishment

Notes: Affecting car performance/damage cannot be used whilst playing online.
Precautions

- This disc contains software for the PlayStation2 computer entertainment system. Never use this disc on any other system, as it could damage it.
- This disc conforms to PlayStation2 specifications for the PAL market only. It cannot be used on other specification versions of PlayStation2.
- Read the PlayStation2 Instruction Manual carefully to ensure correct usage.
- When inserting this disc in the PlayStation2 always place it with the required playback side facing down.
- When handling the disc, do not touch the surface. Hold it by the edge.
- Keep the disc clean and free of scratches. Should the surface become dirty, wipe it gently with a soft, dry cloth.
- Do not leave the disc near heat sources or in direct sunlight or excessive moisture.
- Do not use an irregularly shaped disc, a cracked or warped disc, or one that has been repaired with adhesives, as this could lead to malfunction.

Health Warning

For your health, be sure to take a break of about 15 minutes during every hour of play. Avoid playing when tired or suffering from lack of sleep. Always play in a well-lit room, sitting as far from the screen as the cord will allow. Some people experience epileptic seizures when viewing flashing lights or patterns in our daily environment. These people may experience seizures while watching TV pictures or playing video games. Even players who have never had any seizures may nonetheless have an undetected epileptic condition. Consult your doctor before playing video games if you have an epileptic condition or immediately if you experience any of the following symptoms during play: dizziness, altered vision, muscle twitching, other involuntary movements, loss of awareness of your surroundings, mental confusion, and/or convulsions.

PIRACY

The unauthorized reproduction of all or any game part of this product and the unauthorized use of registered trademarks are likely to constitute a criminal offense. PIRACY harms Consumers as well as legitimate Developers, Publishers and Retailers. If you suspect this game product is an unauthorized copy, or have any other information about pirate product, please call your local Customer Service number given at the back of this Manual.

See back page of this manual for Customer Service Numbers.

Pan European Games Information (PEGI) Age-Rating System

The PEGI age-rating system protects minors from games unsuitable for their particular age group. PLEASE NOTE: it is not a guide to gaming difficulty. By combining two parts, PEGI allows parents and those purchasing games for children to make an informed choice appropriate to the age of the intended player. The first part is an age rating:

3 7+ 12+ 16+ 18+

The second is a code indicating the type of content in the game. Depending on the game, there may be a number of such icons. The age rating of the game reflects the intensity of this content. The icons are:

- VIOLENCE
- BAD LANGUAGE
- FEAR
- SEXUAL CONTENT
- DRUGS
- DISCRIMINATION

For further information visit http://www.pegi.info
**GETTING STARTED**

Set up your PlayStation2 computer entertainment system according to the instructions in its Instruction Manual. Attach game controllers and other accessories, as appropriate. It is recommended that you do not insert or remove memory cards (8MB) (for PlayStation2) or other accessories once the power is switched on. An analog controller (DUALSHOCK@2) must always be inserted into controller port 1. Make sure there is enough free space on your memory card (8MB) (for PlayStation2) before commencing play. Refer to the instructions supplied with the memory card (8MB) (for PlayStation2) for details.

Make sure the MAIN POWER switch (located on the back of the console) is turned on. Press the 0 / RESET button. When the E irradiation is green, press the 0 button and the disc tray will open. Place the game disc on the disc tray with the label side facing up. Press the R2 button again and the disc tray will close. Follow on-screen instructions and refer to this manual for information on using the software.

Note: ToCA Race Driver™3 supports the use of MEMORY CARD slot 1 only.

**MEMORY CARDS (8MB) (FOR PLAYSTATION2)**

This game uses an Autosave feature; as you play through the game, your progress and level of unlocks are saved to memory card (8MB) (for PlayStation2). Make sure there is sufficient space on your memory card (8MB) (for PlayStation2) before commencing play (save file size 210KB minimum).

**ANALOG CONTROLLER (DUALSHOCK@2)**

The analog controller (DUALSHOCK@) and the digital controller are not supported by this title.

---

**GAME CONTROLS**

- Look behind
- Look right
- Boost
- Change camera
- Handbrake
- Accelerate
- Brake
- Steer left/right
- Pause

---

**Steering Wheel Controllers**

This game supports the use of the Logitech GT Force, Driving Force and the Driving Force Pro USB Steering Wheel controllers.

If using a USB steering wheel controller, ensure that it is connected before pressing the START button to begin the game. Press the START button on the relevant controller, which must be used thereafter during that session.

If your USB steering wheel controller supports multi-turn mode, this can be activated through Main Menu > Options > Driving. For full controller configurations please see Main Menu > Options > Driving > Control Assignments.

**Menu Navigation**

- Highlight Menu Item: Directional buttons or left analog stick.
- Change menu option where available: Directional buttons or left analog stick
- Select highlighted menu item: X button or START button
- Cancel/exit menu: Δ button
STARTING THE GAME

Player Profile

Once the game has loaded, either select an existing player profile or create a new one. You will need to create a new profile if you are loading the game for the first time.

Creating a New Profile

First select a save slot to store your profile in. As you continue through your driving career, all of your progress and the features that you have unlocked will be saved to this profile.

Next set up your profile details and then select 'Done'. Finally complete your profile by defining your game options (see Options for more information). When you have finished, select 'Begin' to start your career.

Your Racing Career

This is your chance to make a name for yourself in the racing world. Along the way you will take part in a wide range of very different championships featuring a wealth of cars, each providing unique challenges.

Success will not come easily. Not only will you have to adapt to very different racing styles, you will also have to be aware of other drivers who want to claim the crown for themselves.

The World Tour mode is where it all starts and making your way up the career ladder is one of the ways that you can unlock more vehicles and tracks that you can then use in the other game modes.

In Pro Career mode you earn cups for winning each of the championships. One cup is awarded for completing the championship in normal mode, another one for hard mode and one for setting the fastest lap on each of the tracks in that championship (Time Trial only). These cups can then be used to unlock additional bonus content. It is also possible to unlock Championships by competing in on-line races.

THE GAME SCREEN

1. Lap Indicator: Number of laps completed so far.
2. Position Indicator: Your current position in the race.
3. Current Time Indicator: The total race time elapsed so far.
4. Lap Time: The time elapsed so far on your current lap.
5. Best Time: Shows your record lap time for the current track.
6. Accelerator/Brake Gauge: The amount of force applied to the accelerator/brake pedal.
7. G Meter: Shows the amount of g-force currently being generated.
8. Gear Icon: Your currently selected gear.
10. Speed: Your speed in miles per hour.
11. Mini Map: Your position and the position of your nearest competitors on the current circuit. Your car appears as an arrow.
12. Stage Progress: Shows your progress through the Rally Stage.
13. Split Time: Represents the fastest recorded time through each section of the rally. If it's green you are currently the fastest, if it's red then a quicker time has been recorded.
14. Rally Corner Indicator: Indicates the direction of the road ahead.
15. Damage Indicator: Illuminates from yellow (minimal) through to red (serious) as components of your car start to become damaged. You are able to repair your car in the Pits (where available) but if your car becomes seriously damaged to the point that you are unable to complete the race, you can opt to retire (via the Pause Menu).

Although all vehicles suffer damage they are all affected differently. For example Open-wheel cars are much more fragile and more susceptible to damage to their tyres and wheels. Trucks on the other hand are much more robust and can take much more punishment. It is important to be mindful of these differences and adapt your racing style accordingly.

Note: If you receive terminal damage and components can no longer function then you are automatically retired from the race.
**DAMAGE**

**GEARS**
Damage to your gearbox can prevent your car from reaching its top speed. Damage to this component can also reduce your ability to change from gear to gear. The gearbox can be damaged by either the player changing down incorrectly through the gears (in manual mode), or by a head-on impact.

**STEERING**
Steering damage will reduce vehicle responsiveness. Severe damage will cause the vehicle to pull in one direction, making it difficult to control at high speeds. The steering can be damaged by front or side-on impacts, or by driving the vehicle across the infield at high speeds.

**SUSPENSION**
Suspension damage will affect road holding and cornering ability. Severe damage will increase the possibility of the car bottoming out. The suspension can be damaged by the vehicle being involved in impacts or by the player driving the vehicle across the infield areas at high speed.

**ENGINE**
Engine damage will seriously reduce vehicle performance, reducing top speed and acceleration. Engine damage occurs during collisions and once damaged, the time taken for the engine to overheat will decrease. A bar underneath the engine icon shows its current temperature.

**WHEELS**
Damage to the wheels reduces the stability and handling of the car. The loss of a wheel can lead to you being unable to complete the remainder of the race. A bar underneath the wheel icon shows the current tyre temperature.

**TYRE WEAR**
As tyres wear down they begin to lose grip on the track surface. Driving across the infield will wear down tyres faster and should be avoided.

**Main Menu – Overview**

The Main Menu is where you can start your motor-racing career. Here you can access the Simulation Modes as below, as well as the main World Tour and Pro-Career modes described later on pages 12 & 14. World Tour gives you the freedom to jump from one motorsport discipline to another with less emphasis on rules and flags, whereas Pro-Career focuses on truly mastering an individual motorsport at a time.

**Simulation Modes**

In the Simulation Menu you can choose from the following options:

**Free Race:** This mode allows you to play through any of the Championships that have been previously unlocked in World Tour or Pro-Career mode. In Free Race you can set up the Championship to your own specification, down to the smallest details such as selecting which tracks to race on, which rules and flags will be used, which opponents to race, etc. You can also switch on full race events, and play through the entire Race Calendar for that Championship, including all of the practice and qualifying sessions.

**Select Discipline:** Scroll left or right to select which discipline you want to race in. Above each discipline is a description detailing what sort of racing to expect.

**Championship Select:** After selecting the discipline you are now ready to start setting up your Championship. Scroll left/right to select the type of Championship that you want. You can then select which tracks you would like to race on, or select to race on the entire calendar. Once you are happy with the selected tracks you can choose which car you would like to use.

**Championship Set-up:** Having selected the type of race, the tracks and the car, you can adjust the finer details of your Championship. Here you can set which rules or flags you wish to have, as well as the number of laps, how many opponents will be competing with you and how you want the grid position to be determined.

**Time Trial:** Use Time Trial to test your best lap times on any of the circuits that you have unlocked from any of the Championships.

**Multiplayer:** A chance to play on any of the circuits in two player split-screen mode. Both players need to press the START button to join the game, then Player 1 selects the options as in Free Race mode. The race commences once Player 2 has selected their car.
Network

Select 'Network' to start a multi-player race against other players across networked consoles.

Network and online multiplay require the presence of a Network Adapter (Ethernet) (for PlayStation2) and a correctly configured broadband internet connection. These are purchased separately and should be installed according to the manufacturer's instructions.

Join: Enter the lobby of a game that has been created on another networked console. Change your car, team and driver if you wish. Once you are happy with your selection press the □ button to ready yourself. Once the host has selected 'Ready' anyone who is not ready will have 15 seconds to press ready before the race begins.

Create: Use the options shown on screen to define the parameters of the game you are hosting. When you are finished press 'Start Session' to go to the race lobby. Your game will appear on the Join List of any consoles running the game on the same network. You can change the session settings and which championship to race on, and which cars to use from the lobby menu, by returning to the Session Settings menu.

When you are ready to hit the track, select 'Ready'. This starts a 15 second countdown to start race, visible on all players' screens. Players who do not select ready before the countdown ends will be left out of the race.

PLAY ONLINE

Select 'Play Online' to take part in a multi-player game online.

Sign In: ToCA Race Driver™3 uses the Gamespy ID Login system. You may create a new Gamespy ID or use an Existing Gamespy ID by entering your details in the 'New Account' Screen. You can manage your Gamespy ID at www.GameSpy10.com.

You may prevent unauthorised use of your Gamespy ID by entering a 4-button Passcode in 'New Account' screen. If you choose to enter a 4-button Passcode, you will be asked to re-enter it each time you sign in.

Quick Game: Quick Game is the fastest and easiest way to get into a game. It finds the first game running that you are able to join. Select 'Join' to enter the game displayed, or 'Find Next' to bring up the next available game.

Browse Sessions: Use this option to specify exactly what type of game you would like to join. Use the navigation controls to define the criteria for your game search, and then select 'Search' to display a list of games running that match your preferences. Highlight a game on the list and press the X button to join the lobby of that game.

Create Session: Select 'Create Session' then follow the options on screen to set up your own online game for other players to join.

Lobby: Before the start of an online race, all players enter the lobby to prepare. From here you can choose your team/car. The host will also decide whether they want Full Race Rules and Flags to be used in the session or not. Once you are happy with all the selections that you have made select 'Ready' to indicate to the host of the game that you have finished setting everything up and are ready to go. If any players are not ready 15 seconds after the host has selected 'Ready', the game will begin regardless of whether other players have selected 'Ready' or not.

Spectator Mode: If you join a game session where others are already racing you can watch the progress of their race by pressing the □ button.

The communication function of this product includes software developed by the NetBSD Foundation, Inc. and its contributors. For a complete list of contributors please see LIBEENET.TXT in the disc.

RSA RSAFE and Crypto-C software from RSA Security Inc. have been installed. RSA is a registered trademark of RSA Security Inc. RSAF® is a registered trademark of RSA Security Inc. in the United States and other countries. RSA Security Inc. All rights reserved.

DNAS logotype is a trademark of Sony Computer Entertainment Inc.
Options

Profile
Select Profile to give yourself a name that can be used in career and other race modes. You can also select which language you want the game to be displayed in as well as your nationality. You can also define your keyboard layout if you have a USB keyboard connected.

Driving
Select ‘Driving’ to define your driving style and controller preferences.

Control Assignments:
To re-define a control, highlight the function and press the X button. Then press whichever button you want to re-assign to that function. If at any point you want to restore everything back to the default settings press the ○ button.

Advanced:
Adjusts your controller's dead zone and saturation settings.

Vibration:
Turn vibration on or off.

Gearbox:
- Select 'Automatic' and gears will change automatically - great for novices.
- Select 'Manual' to give you full control over when you change gear.
- Select 'Manual with Clutch' for complete driving control - for very experienced drivers.

Pro-Simulation:
Turning on any of the Pro-Simulation handling options makes the whole driving experience much more realistic and therefore much more difficult. These options should only be turned on if you are a very confident driver.

Graphics:
Select Graphics to determine which on-screen display elements you wish to have ‘on’ or ‘off’, as well as adjusting the screen position.

Sound:
Select Sound to set the Volume of the various sound elements. You can also select the sound type (mono, headphones, stereo or surround).

Bonus:
Select Bonus to enter or activate any Bonus Codes you have. See the back of the manual for how to obtain these codes.

Network:
Change any of the available Network Configuration Options.

Pro-Simulation Handling: With this turned on your car will not only be more tricky to drive, it will also suffer from much more realistic damage. This mode is for elite drivers who want the full authentic experience.
WORLD TOUR

Overview

World Tour mode offers you a motorsport career taking you through a wealth of different championships. Your career will begin with the chance to compete in one of two opening motorsports on offer: the Global GT Lights and the Autosport Clio Cup. Success in these championships will enable you to climb the career ladder, getting an opportunity to take part in a diverse selection of motorsport such as the British GT, DTM and V8 Supercar Championship Series. Success in these will ultimately provide you with the chance to drive for the BMW Williams F1 Team.

Meet Rick

Rick will manage you as you make your way through your career. He will keep you on your toes and make sure you are getting the best out of the cars you will be competing in. Whilst you are racing he will keep in contact with you through the pit radio, letting you know about any problems and relaying important info to you. Be warned though, Rick doesn’t pull any punches! He will tell it to you just how it is, so the only way to keep him happy is to keep on winning all of those Championships!

Tiers

The mode consists of multiple tiers. Within each tier you have several championship options to choose from. There is always a choice of at least two championships and in most cases there are three. There is an exception to this rule; the last two tiers consist of championships featuring Williams F1 challenges where there are no other choices.

Flexibility

In World Tour you can progress your career up and down through the tiers that you have already completed. In order to qualify for a new tier you must complete at least one of the objectives on the previous one. Once you have completed a championship you unlock it along with the car that you raced and the tracks that you raced on. It is also possible to unlock tiers by competing in online races.

Championships

All of the main championships featured in the game are in the World Tour mode. The championships do not all feature the full race calendars and formats. If you want to play races with full Calendars and rules head over to the Pro Career mode.

Pit Stops

If your car is suffering from damage or you are running low on fuel it is time to come into the pits. For each repair there is a time allocated so you can see how long it will take. In addition an overall pit stop time is given. You can alter the time of the pit stop by changing the level of repairs and how much fuel is going into the car. In certain Championships there will be mandatory pit stops. This means that you must come into the pits to either change your tyres or refuel. Rick will tell you which laps you should come in on.
**PRO CAREER MODE**

The Pro Career mode allows you to pick a motor racing discipline and play through each championship in a realistic manner with full race rules, calendars, flags etc.

- The classic discipline allows you to compete in some of the most famous racing cars ever raced. From the 1930s championship winning Mercedes W25 to the powerful muscle cars of the '70s.

- Race some of the most prestigious and exotic sports cars in the GT discipline. Take part in multi-class races, and get to grips with some of the most powerful racing cars in the world of motorsport.

- From dirt ovals, to the legendary Indianapolis Motor Speedway, experience the excitement of the world’s fastest professional motor sport.

- The Touring Car discipline is about aggressive, high-octane, pack racing. Ultimately aiming to earn a place in either the DTM or V8 Supercar Championship Series.

- From Rally, to Baja, Nissan Dakar to Rally Cross, experience every level of Off Road racing in the Off Road discipline. The challenge in this thrilling style of racing is not only master your vehicle, but also the environment.

- Perhaps one of the most technically difficult disciplines, Open Wheel demands that drivers fully understand the nuances of each track and vehicle. The secret here is all about the racing line, and taking great care to avoid contact in these fragile machines.

- Compete in a series of time trial events at the 400-acre Bedford Autodrome Complex. Each event takes place in a different car and circuit at the site.

- This discipline features a selection of unique and challenging Championships, pitting players in a number of different Honda cars and vehicles.

**RULES AND FLAGS**

In Free Race and Pro Career mode you can opt to use full race rules and flags. Below is a list of the flags used in the game and what they indicate. These flags and the rules associated with them can be turned on or off on the Championship Set-up screen.

- Commonly referred to as the passing flag and indicates that a driver should be aware of a faster car attempting to lap them.

- The black flag indicates that the driver has received either a timed or pit penalty.

- The Yellow Flag is displayed as a warning of an accident ahead. Overtaking is forbidden whilst the yellow flag is out.

- The green flag (waved after yellow) signals the end of a caution period. Drivers can resume to race speed.

- The white flag indicates that the driver has commenced their last lap of the race or can mean (in certain championships) that there is a much slower vehicle on the sector of track controlled by that flag post.

- A black and white diagonally divided flag is shown to drivers for unsportsmanlike behaviour on the track, such as careless driving or corner cutting.

- A black flag with an orange circle is shown to drivers whose vehicles have mechanical problems. Drivers shown this flag must return to the pits as soon as possible.

**Shootouts:** In some Championships after the initial qualifying round a shootout (or Super-Pole in DTM) takes place. This is when the top ten drivers from the first qualifying round complete a single timed lap, which determines the top ten places on the grid.
CAR TUNING

In Time Trial, Free Race and Pro-Career modes you can tune your vehicle to adjust its performance. Although races can be won by just using the standard settings in order to set the very best lap times you may find that you need to tweak your settings slightly. If you press the button after selecting any of the components, you will be provided with a detailed description of the ways in which they affect your car.

Note: Car Tuning is not available in all Championships and not all set-up options will be available to all vehicles.

Downforce: Downforce is created when air is channelled over the vehicle body. Downforce increases grip, but it also increases drag, which can reduce top end speed. To adjust downforce highlight the front or rear of the car and use the left analog stick or directional buttons to adjust the setting of each.

Transmission: In order to get the best acceleration the gears need to be set very close together, this however reduces the car’s top speed dramatically. In turn spacing the gear ratios out improves the car’s top speed but greatly reduces acceleration. To adjust your gears highlight each one individually and adjust its values.

Anti Roll: An anti-roll bar is a metal bar that links both wheels on the same axle to the chassis making it harder for the driver-side and passenger-side suspensions to move in opposite directions. This reduces the vehicle’s roll and greatly increases its grip. To adjust anti roll highlight the front or rear of the car and use the left analog stick or directional buttons to alter the setting of each.

Tyre Compound: Tyre compound is a measure of how hard or soft the tyre is. Softer tyres afford more grip but wear out quicker and provide slightly less steering response. Harder tyres produce less grip but last much longer and give slightly better steering response. To adjust your tyre compound move the slider left or right depending on whether you want it to be hard or soft.

Tyre Profile: Tyre profile is the measurement from the outer edge of the tyre to the inner rim. Compared to conventional passenger car tyres, low profile car tyres have a greater width ratio to cope with the demands of higher performance vehicles. To adjust your tyre profile highlight the front or rear of the car and use the left analog stick or directional buttons to adjust its values.

Brake Bias: Adjusting brake bias affects the way your vehicle handles in the bends. When you decelerate, the weight of your car is forced forwards onto the front wheels. This will increase front grip but may well make the back of your vehicle light. This can improve steering into tight corners as it will help to shift the back of the car around, but combined with too much speed it can easily send your car into an uncontrollable spin.

Care is needed in putting too much bias on the front wheels as it can make your brakes lock more easily, and when this happens it is impossible to steer. To adjust your brake bias move the slider left or right depending on whether you want it to be toward the rear or the front of the car.

Ride Height: Adjusting ride height changes the working range of the car’s suspension. A high ride height gives the greatest range to the shocks, but also increases the likelihood of body roll along with reduced downforce and grip. To adjust the ride height, highlight the front or rear of the car and use the left analog stick or directional buttons to adjust the values of each.

Suspension: Suspension affects the car’s road holding abilities and the ability to handle cornering at speed. Setting the suspension to ‘soft’ will allow the car to cope better with uneven surfaces, as each wheel is able to maintain contact with the ground for longer. If it is too soft though, your car will be susceptible to body-roll on bends. Hard suspension improves your corner taking ability, but on rougher terrain you will find your grip markedly reduced. To adjust the suspension highlight the front or rear settings and use the left analog stick or directional buttons to adjust the values of each.

Toe and Camber: When the wheels are set so their leading edges are pointed slightly towards each other they are said to have toe-in. If they are set pointing away from each other they are said to have toe-out. Toe settings affect tyre wear, straight-line speed and stability, and there is a trade-off between the straight-line stability afforded by toe-in and the quick steering response promoted by toe-out. To adjust the toe, highlight the front or rear settings and use the left analog stick or directional buttons to adjust the values of each.

Camber is the tilt of the tyre as viewed from the front of the car. If the tyres tilt toward the centre on the car you have negative camber and if it tilts away from the centre you have positive camber. Adjusting camber can have a dramatic effect on the steering of the car. To adjust the camber, highlight the front or rear settings and use the left analog stick or directional buttons to adjust the values of each.
CAR UPGRADES

In certain Championships you are able to upgrade the various components of the car. Such upgrades increase the overall BHP of the car, (at the expense of fuel efficiency) brake strength, engine performance, structural stability, etc. To install the upgrade that you want, scroll left or right to highlight it and press the \X button to install. Below each icon it tells you how many slots each upgrade will take. The total upgrade slots you have available are shown in the top left of the screen. If you press the \□ button on this screen it will provide you with a detailed description of how the various upgrades affect the performance of the car.

**Induction Kits:** Increase BHP - Decrease Fuel Efficiency

**Brake Kits:** Increase brake strength

**Brake Hoses:** Increase brake strength

**Cams:** Increase BHP - Decrease Fuel Efficiency

**Clutches:** Increase BHP

**Dump Valves:** Increase BHP

**Electronics:** Increase BHP - Increase Fuel Efficiency

**Engine Tuning:** Increase BHP - Increase Fuel Efficiency

**Engine Hoses:** Decrease engine overheating

**Exhausts:** Increase BHP - Increase Fuel Efficiency

**Flywheels:** Increase BHP - Increase Fuel Efficiency

**Ignition Kits:** Increase BHP - Increase Fuel Efficiency

**Intercoolers:** Increase BHP - Decrease Fuel Efficiency

**Oil Coolers:** Decrease engine overheating

**Roll Cages:** Increase performance and resistance to mechanical damage

**Seats:** Increase structural stability

**Strut Braces:** Increase performance and resistance to mechanical damage

**Suspension Kits:** Decrease suspension damage

**Transmission Kits:** Increase Gear Speed and performance

**Turbochargers:** Increase BHP - Decrease Fuel Efficiency

**Tyres:** Increase traction and decrease tyre wear

**Wheels:** Decrease axle and tyre damage

TELEMETRY

After completing a qualifying session or test drive on any track you can view the telemetry data, which shows your speed at each part of the track, as well as when you were applying the brake or throttle. You can then compare data from previous attempts to find areas where you can improve. Pressing the \□ button zooms in so you can see the data in more detail and the \○ button is used to load the data from previous attempts.
SPECIAL THANKS TO

Frauke Meyer, Christoph Hewer, WM GmbH, The Board Members of the ITR e.V.
The DTM Championship and all of the teams, drivers, car manufacturers, circuits
and sponsors associated with the series. Tracey Benton, Jenny Babbage, Basil
Scaffidi. The Board Members of V8 Supercars Australia Pty Limited CAN 077 053 484,
Australian V8 Supercar Championship and all of the teams, drivers, car manufacturers,
circuits and sponsors associated with the series. Neil Vandegrift and Nicole Polsky,
Indianapolis Motor Speedway.

CREDITS

This product is manufactured and distributed under license from International Management
Group of America Pty Limited.

Trademarks, design patents and copyrights are used with the approval of the owner
AUDI AG.

The BMW logo, the BMW WilliamsF1 logo, the BMW wordmark and the BMW model
designations are Trademarks of BMW AG and are used under license.

Dodge is a trademark of DaimlerChrysler Corporation.

All Fiat cars, car parts, names, brands and associated imagery featured in this game are
intellectual property rights including trademarks and/or copyrighted materials of Fiat S.p.A. All rights reserved.

The Buick Gran Sport 455, Chevrolet Silverado, Pontiac Firebird, Corvette C5 and Corvette
C5R are General Motors Trademarks used under license to Codemasters Software
Company Ltd.

Original Music Composed and Arranged by Nimrod Productions Limited
www.nimrodproductions.com

DaimlerChrysler, Three Pointed Star in a Ring and Three Pointed Star in a Laurel Wreath
and Mercedes-Benz are Trademarks of and licensed courtesy of DaimlerChrysler AG and
are used under license to The Codemasters Software Company Ltd.

Renault Official License Products are vehicle models and trademarks protected by
intellectual property laws. Used with permission from Renault. All rights reserved.

General Motors' Vauxhall VX220 and Vauxhall Monaro, all related Emblems and vehicle
designs are Vauxhall Motors Limited Trademarks used under license to Codemasters
Software Company Ltd.

Trademarks, design patents and copyrights are used with the permission of the owner
Volkswagen AG.

"IRL", "Indy Racing League", "IndyCar", "Indianapolis 500", "Indy 500", "Indianapolis
Motor Speedway" and "The Greatest Spectacle in Racing" are registered trademarks of
Brickyard Trademarks, Inc., used under license.